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Installation overview
Task
Ensure your computers meet the minimum requirements.
Obtain the installation packages and supporting files.
Customize the installation packages using SMART Install Manager.

Reference
page 2
page 3
page 5

OR

OR

Customize the installation packages using a third-party tool.
Deploy the installation packages.

page 12
page 13

N OTE
Please send any feedback on this guide to DocumentationFeedback@smarttech.com.
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Chapter 1

Getting started
Computer requirements
For one- or two-display systems
For three- to eight-display systems
For nine- to 16-display systems
Installation packages and supporting files
Installation packages
Third-party installation packages
SMART software installation packages
Language files

This guide explains how to customize and deploy SMART Meeting Pro™ software.
This guide is intended for IT administrators and others experienced with customizing, deploying and
administering Windows® software in a networked environment. To use this guide, you must
l

Know IT terminology such as “registry” and “domain controller”

l

Know how to complete basic administrative tasks in Windows operating systems such as
modifying the registry

l

Have administrative privileges and access to servers

l

Have Internet access
I MPOR TA N T

You must run the commands documented in this guide in an Administrator Command Prompt
window. To open an Administrator Command Prompt window, right-click the Command Prompt
icon, and then select Run as Administrator.
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Computer requirements
Before you install SMART Meeting Pro software, ensure your computers meet the minimum
requirements defined in this section.
N OTE
If you’re deploying SMART software to Windows XP computers, you must first install Windows
Installer 4.5 on these computers. You can download Windows Installer 4.5 from
support.microsoft.com/kb/942288.

For one- or two-display systems
l

Windows XP SP3 or Windows 7 operating systems

l

2.0 GHz dual-core processor or faster (quad-core recommended)

l

1 GB of RAM for Windows XP or 2 GB of RAM (4 GB recommended) for Windows 7

l

Discrete 128 MB VRAM and support for DirectX® 9 technology

l

1 GB of free hard disk space for minimum installation (additional free space required during
installation)

l

10 Mbps network connection (100 Mbps recommended) supporting TCP/IP

For three- to eight-display systems
l

Windows XP SP3 or Windows 7 operating systems

l

2.0 GHz dual-core processor or faster (quad-core recommended)

l

3 GB of RAM for Windows XP or 4 GB of RAM for Windows 7

l

Discrete 128 MB VRAM and support for DirectX 9 technology

l

1 GB of free hard disk space for minimum installation (additional free space required during
installation)

l

10 Mbps network connection (100 Mbps recommended) supporting TCP/IP

For nine- to 16-display systems
l

Windows XP SP3 or Windows 7 operating systems (Windows 7 with Advanced Aero® theme
disabled recommended)
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l

3.0 GHz dual-core processor or faster (quad-core recommended)

l

8 GB of RAM or more
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l

Discrete 256 MB VRAM and support for DirectX 9 technology

l

1 GB of free hard disk space for minimum installation (additional free space required during
installation)
10 Mbps network connection (100 Mbps recommended) supporting TCP/IP

l

Installation packages and supporting files
Before you can customize or deploy SMART software, you must locate the installation packages and
supporting files.

Installation packages
Third-party installation packages
Before deploying the SMART software installation packages, you must deploy the following third-party installation packages:
If you want to install this software:
SMART Meeting Pro software
SMART Product Drivers
(including SMART Ink™)

Deploy these installation packages:
l

l

l

Microsoft® .NET framework 4.0 full files
(dotNetFx40_Full_x86_x64.exe)
Microsoft .NET framework 4.0 full files
(dotNetFx40_Full_x86_x64.exe)
Microsoft Visual Studio® Tools for Office
(vstor40_x86.exe for 32-bit computers or
vstor40_x64.exe for 64-bit computers running
32-bit or 64-bit versions of Microsoft Office)

Download these third-party installation packages from smarttech.com/administratordownloads.
N OTES
l

For information on deploying the Microsoft .NET framework, refer to the .NET framework
deployment guide for administrators on the MSDN® website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

l

For more information on deploying Microsoft Visual Studio Tools for Office, refer to the How
to: Install the Visual Studio Tools for Office Runtime Redistributable on the MSDN website
(msdn.microsoft.com/en-us/library/ms178739.aspx).

SMART software installation packages
There’s one installation package (also known as an MSI file) for SMART Product Drivers 11 and one
installation package for SMART Meeting Pro software.
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Installation package

File name

SMART Product Drivers

SMART Product Drivers Installer.msi

SMART Meeting Pro software

SMART Meeting Pro.msi

I MPOR TA N T
l

Before deploying the SMART software installation packages, you must deploy the following
third-party packages: Microsoft .NET framework 4.0 full files and Microsoft Visual Studio
Tools for Office (see Installation packages on the previous page).

l

The SMART Product Drivers installation package includes SMART Ink and SMART
Common Files. You must deploy the SMART Product Drivers installation package before
you deploy the SMART Meeting Pro software installation package.

Download these installation packages from smarttech.com/administratordownloads.
Save the packages in a location on your network that’s accessible to all computers on which you plan
to install the software.

Language files
If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
corresponding MST file for the language is in the same folder as the MSI file (see Installation
language files and codes on page 31).
Similarly, if you want users to be able to view and use the software in a language other than English,
you must download and install the appropriate language pack (see Language packs on page 32).
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Chapter 2

Customizing installation
packages
Using SMART Install Manager
Installing SMART Install Manager
Using SMART Install Manager
Opening an installation package
Saving your changes
Publishing your changes as an MST file
Customizing the SMART Meeting Pro installation package
Customizing the SMART Product Drivers installation package
Using third-party tools

You can customize installation packages using SMART Install Manager.
OR
You can customize installation packages using third-party tools and Windows Installer properties.

Using SMART Install Manager
SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishing MST files. You can then deploy the MSI and MST files to
computers using third-party imaging or remote management software.

Installing SMART Install Manager
Download and install SMART Install Manager from the SMART Support website.
g To install SMART Install Manager from the website
1. Go to smarttech.com/administratordownloads.
2. Scroll to SMART Meeting Pro software, click Choose a version, and then select SMART
Meeting Pro software > 3.0 for Windows.

5

5
5
6
6
7
7
8
10
12

CHAPT ER 2
Customizing installation packages

3. Click Download SMART Install Manager, and then click Download.
N OTE
SMART Install Manager version 1.1.36.0 or newer is required if your product key has 25
characters.
4. Save the Install Manager.exe file to your computer.
5. Double-click the Install Manager.exe file.
The SMART Install Manager installation wizard appears.
6. Follow the on-screen instructions.

Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu under All Programs > SMART Technologies > SMART Install Manager.
With SMART Install Manager, you can do the following:
l

Open and customize an installation package.

l

Save your changes to the installation package as an XML file.

l

Publish your changes to the installation packages as an MST file.

Opening an installation package
To customize an installation package, drag its MSI file into the SMART Install Manager window.
Alternatively, you can search for installation packages on your computer by clicking

.

N OTE
All installation packages you’ve previously opened in SMART Install Manager appear in the
Unmodified Packages tab.
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

Saving your changes
After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening the MSI file and then selecting File > Import.
Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as an MST file. To do this, select File > Publish, and then use the dialog box to define a
location for and create the MST file.
TIP
If you use an older MST file created with an earlier version of the MSI file, it might not work properly.
Use the current MSI file to create your MST file. Publish the MST file in the same location as the
MSI file.
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Customizing the SMART Meeting Pro installation package
To customize the SMART Meeting Pro installation package, open the SMART Meeting Pro.msi file
in SMART Install Manager (see Using SMART Install Manager on page 6), and then set the controls
on each page.
Control
Installation Options

Procedure

Type the path to your preferred folder
Installation directory
for SMART Meeting Pro software.

Product key

Activate SMART
Meeting Pro during
installation

Notes
If you don’t specify a folder, Windows
Installer installs SMART Meeting Pro
software in [Program files]\SMART
Technologies\SMART Meeting Pro.
You can type the product key with or
without hyphens.

Type your 22- or 25-character product
When you type a volume product key,
key for SMART Meeting Pro software.
the software activates when you deploy
it to your network computers.
Select to activate SMART Meeting Pro
software automatically during
installation rather than manually after
installation.

Shortcuts
Select to create shortcuts to
SMART Meeting Pro software on the
desktop.
Launch
Select to start SMART Meeting Pro
SMART Meeting Pro software automatically when the user
at Startup
logs on.
Microsoft Exchange and E-mail Server Settings
Select to enable Microsoft Exchange
integration with SMART Meeting Pro
software.
Install Desktop
shortcut

I MPOR TA N T
Enable integration
You must also add the room
resource’s unique e-mail address
Exchange
after installation or Microsoft
Exchange integration will be disabled
(see Adding a unique e-mail address
to each computer after installation on
page 17).
Select to automatically start scheduled
Auto start scheduled
meetings each time a user starts a new
meeting at logon
session.
with Microsoft

8

Users can access their Microsoft
Outlook® meeting details and e-mail
Whiteboard files to themselves or to
other users in SMART Meeting Pro
software.
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Control

Procedure
Select to automatically book and start
Auto book ad hoc
an unscheduled meeting each time a
meeting at logon
user starts a new session.
Auto reset room
Select to automatically reset the room
after meeting end
5 minutes after a meeting’s scheduled
time and a delay of 5 end time. Use the drop-down menu to
minutes
change the delay time.
Select to automatically insert meeting
Auto insert agenda
details into the drawing area each time
at meeting start
a scheduled meeting starts.

Notes

If you don’t enable Microsoft Exchange
integration settings, you can still
Select to configure SMTP e-mail
Enable SMTP e-mail
configure SMTP e-mail settings. Users
settings or the computer’s default econfiguration
are unable to access their Microsoft
mail client.
Outlook meeting details, but can still
e-mail Whiteboard files.
Users can e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software. The
software uses this e-mail address in the
Type the sender e-mail address for the
Sender field.
Sender e-mail
SMART Meeting Pro software
address
If the computer doesn’t have an e-mail
installation.
client installed, enter a do not reply
value. This indicates to mail recipients
that they can’t reply to e-mails they
receive.
Users can e-mail Whiteboard files to
themselves or to other users in
SMTP server name Type the name of the SMTP server.
SMART Meeting Pro software. The
software uses this e-mail server to
send the file.
Use the computer’s
The default e-mail client must be
default e-mail client Select to use the computer’s default eproperly configured for e-mail to be
to send e-mail
mail client to send e-mail messages.
sent.
messages.
Bridgit server Information
The SMART Bridgit server enables the
SMART Meeting Pro software
Type the name of the SMART Bridgit®
installation to connect to other
Bridgit Server
server (for example,
SMART Meeting Pro software
bridgit.example.com).
installations. For more information, see
smarttech.com/bridgit.
Type the access password for the
Access password
SMART Bridgit server.
Type the creation password for the
Creation password
SMART Bridgit server.
Automatically share Select to share the main screen each
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Control
Procedure
primary screen
time a user starts a new session.
Additional Configuration
Select Calligraphic to use calligraphic
ink, which smoothes your writing
strokes and improves the readability of
Ink type
your notes.

Notes

OR
Select Regular to use regular ink.
Gallery Location

Save Gallery
content added by
user in:

Additional Gallery
Folder (optional):

Type the path to your preferred folder
for added content. If you don’t specify a
folder, added content is stored in the
The Added Content folder is a location
following default folder:
on the local computer where user[PublicDocumentsFolder]\SMART created content is stored.
Technologies\Gallery\Added
Content.
Type the path to your preferred folder to
add gallery folders.

Customizing the SMART Product Drivers installation package
To customize the SMART Product Drivers installation package, open the SMART Product Drivers
Installer.msi file in SMART Install Manager (see Using SMART Install Manager on page 6), and
then set the controls on each page.
Control
Installation Options

Installation directory

Procedure

Notes

If you don’t specify a folder,
Windows Installer installs
Type the path to your preferred folder SMART Product Drivers in
for SMART Product Drivers.
[Program files]\SMART
Technologies\SMART
Product Drivers.

Language Selection
Select the language packs
Select the language packs you want Some SMART software doesn’t
you want to install
to install.
support all listed languages.
SMART Product Update (SPU) Options
In Full mode, users can view the
Select to install
installed versions of SMART
Install SMART Product
SMART Product Update (SPU) in
software as well as their product
Update in Full Mode
Full mode.
keys, and download and install
updates.
In Dashboard mode, users can
Install SMART Product
Select to install SPU in Dashboard view only the installed versions
Update in Dashboard Mode mode.
of SMART software and their
product keys.
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Control
Do not install SMART
Product Update

Procedure

Notes

Select to not install SPU.
This option is available only if
you install SPU in Full mode.

Check for updates

Type the number of days (1 to 60)
between SPU checks.

Notify users about SMART
product updates

Select to notify users of available
This option is available only if
SMART product updates through the
you install SPU in Full mode.
Windows notification area.

Customer Experience
Enable the Customer
Experience Program on all
devices
Disable the Customer
Experience Program on all
devices
Optional Settings

Select to automatically enable the
Customer Experience Program for all
users.
Select to automatically disable the
Customer Experience Program for all
users.

By default, SPU checks for
product updates every 30 days.

Users can disable the Customer
Experience Program through the
Help menu.
Users can’t enable the
Customer Experience Program
through the Help menu.

Disable the registration of
Register
SMART Document Camera
Select to enable the registration of
SMART Document Camera™
drivers if they conflict with the
SMART Document Camera drivers.
drivers
third-party drivers on the
computer.
If you enable the registration of
unsigned third-party drivers, the
installation process could ask
users if they trust the makers of
the drivers during installation.
Select to enable the registration of
Register unsigned drivers
This can cause issues if you
unsigned third-party drivers.
deploy the installation in Silent
mode. Therefore, it’s best to
disable the registration of
third-party drivers if you deploy
the installation in Silent mode.
Start SMART Board® Tools Select to start SMART Board Tools
at logon
when the user logs on.
Select to use Tablet PC functionality This property is applicable to
with the SMART Board interactive Windows 7 operating system
Enable Tablet PC Support
display without having to connect a only. It has no effect on other
Tablet PC.
operating systems.
Select to start SMART Ink when the
Start SMART Ink at logon
user logs on.
Make SMART Ink Viewer the Select to set SMART Ink Viewer to
default PDF viewer
be the default PDF viewer.
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Using third-party tools
You can customize SMART software installation packages by creating MST files using a third-party
tool, such as Orca database editor, and the Windows Installer properties (see Windows Installer
properties and parameters on page 25).
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Chapter 3

Deploying the software
Using the command line interface
Using third-party imaging or remote management software
Activating the software after installation
Adding a unique e-mail address to each computer after installation

13
15
16
17

You can deploy installation packages using the command line interface.
OR
You can deploy installation packages using third-party imaging or remote management software.
N OTE
You might need to manually activate the software after you deploy it.

Using the command line interface
Using the command line interface, you can deploy installation packages in many ways, including
running commands from the Command Prompt window and including commands in batch script files.
I MPOR TA N T
l

Before deploying the SMART software installation packages, you must deploy the following
third-party packages: Microsoft .NET framework 4.0 full files and Microsoft Visual Studio
Tools for Office (see Installation packages on page 3).

l

The SMART Product Drivers installation package includes SMART Ink and SMART
Common Files. You must deploy the SMART Product Drivers installation package before
you deploy the SMART Meeting Pro software installation package.
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g To install SMART Product Drivers
Run the following command if you created an MST file to customize the installation package:
msiexec /i "[Path]\SMART Product Drivers Installer.msi"
TRANSFORMS="[MST file]" [Parameter]
OR
Run the following command if you didn’t create an MST file to customize the installation package:
msiexec /i "[Path]\SMART Product Drivers Installer.msi" [Properties]
[Parameter]
Where
l

[Path] is the path to the SMART Product Drivers Installer.msi file and MST file.

l

[MST file] is the name of the MST file.

l

[Properties] is a set of properties you can include to customize the installation (see
SMART Product Drivers installation package on page 28).

l

[Parameter] is the installation parameter (see Parameters on page 30).

g To install SMART Meeting Pro software
Run the following command if you created an MST file to customize the installation package:
msiexec /i "[Path]\SMART Meeting Pro.msi" TRANSFORMS="[MST file]"
[Parameter]
OR
Run the following command if you didn’t create an MST file to customize the installation package:
msiexec /i "[Path]\SMART Meeting Pro.msi" [Properties] [Parameter]
Where
l

[Path] is the path to the SMART Meeting Pro.msi file and MST file.

l

[MST file] is the name of the MST file.

l

[Properties] is a set of properties you can include to customize the installation (see
SMART Meeting Pro installation package on page 25).

l

14

[Parameter] is the installation parameter (see Parameters on page 30).
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Using third-party imaging or remote management
software
The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remote management software, see the software’s documentation.
N OTE
This procedure may vary depending on your version of Windows operating system and your system
preferences.
g To deploy an installation package
1. Copy the MSI file and the MST file to \\[Domain Controller]\NETLOGON , where
[Domain Controller] is your domain controller.
2. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.
The Active Directory Users and Computers window appears.
3. Right-click your domain, and then select Properties.
The Properties dialog box appears.
4. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
5. Browse to Computer Configuration\Software Settings.
6. Right-click Software Installation, select New > Package, and then browse to and select the
MSI file from step 1.
7. In the Deploy Software section, click Advanced, and then click OK.
8. Click the Modifications tab, click Add, and then browse to and select the MST file from
step 1.
9. Click OK to apply the MST file to the MSI file.
10. Close all open windows and dialog boxes.
The next time each computer on the domain starts, the computer automatically installs the
software in Silent mode with the customizations defined in the MST file.
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Activating the software after installation
There are two situations in which the software doesn’t activate completely:
l

Imaging a computer: For the software to activate properly, each computer you install it on
must have a unique installation ID. If you use a computer image or clone a hard drive to set up
multiple computers, they all have the same installation ID as the original computer, which can
cause an activation error.

l

Protecting software for computer configurations: If you use system recovery or protection
software, you should activate the software before you lock or freeze the computer for your
users. However, if you can’t, you must activate the software afterward.

Run the activation wizard while connected to the network or complete the following procedure to
activate the software on each computer.
g To activate SMART Meeting Pro software after installation
Run the following command:
"C:\Program Files\Common Files\SMART Technologies\SMART Product
Update\activationwizard.exe" --puid meeting_pro --m=[Value] --v=3 --a
[Optional flags] --pk [Product key]
Where
l

[Value] is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.
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l

l

[Optional flags] are optional flags you can include to configure the activation wizard.
Flag

Purpose

--monitor=[Number]

Specify the monitor to display the activation wizard.

--proxy=[Host:Port]

Specify the proxy host and port number to use for
activation.

--proxyuser=[User]

Specify the proxy user name to use for activation.

--proxypassword=[Password]

Specify the proxy password to use for activation.

--locale=[Code]

Display the activation wizard user interface in a
specific language, where [Code] is your language code
(see Installation language files and codes on page 31).

[Product key] is the software product key.

Adding a unique e-mail address to each
computer after installation
For proper integration of Microsoft Exchange, each computer you install SMART Meeting Pro
software on must have a unique room resource e-mail added in the registry entry.
Complete the following procedure to add a unique room resource e-mail address to the registry entry
of each computer.
C A U TI ON
Use caution when you open the Windows registry editor. If you incorrectly modify the Windows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.
g To add an e-mail address to the registry entry after installation
1. Select START > Run.
The Run dialog box appears.
2. Type regedit, and then click OK.
The Registry Editor window appears.
3. Locate the HKEY_LOCAL_MACHINE\Software\Wow6432Node\SMART
Technologies\SMART Meeting Pro\Version 3.0\MSExchange folder.
N OTE
This path may vary depending on the version of your operating system.
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4. Right-click MeetingRoomEmail, and then select Modify.
5. Type the room resource computer’s unique e-mail address in the Value data box, and then click
OK.
6. Close the Registry Editor window.
7. Restart your computer.
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Removing the software
Using the command line interface
Using third-party imaging or remote management software

19
23

You can remove SMART software using the command line interface.
OR
You can remove SMART software using third-party imaging or remote management software.

Using the command line interface
Using the command line interface, you can remove SMART software in many ways, including
running commands from the Command Prompt window and including commands in batch script files.
I MPOR TA N T
Only remove the common platform after removing all other SMART software.
g To remove SMART Meeting Pro software
Run the following command:
msiexec /x "[Path]\SMART Meeting Pro.msi" [Parameter]
Where
l

[Path] is the path to the SMART Meeting Pro.msi file.

l

[Parameter] is the installation parameter (see Parameters on page 30).

OR
Run the following command to remove the software using the product code:
msiexec /x [Product code] [Parameter]

19
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Where
l

[Product code] is the product code for the version of SMART Meeting Pro software you’re
removing, including the braces (“{” and “}”).

l

Version

Product code

2.0

{596BD3B5-DC48-4AD2-A60A-4C39C9852294}

2.1

{4BD7F008-CDD9-454D-8A5B-4FF8BB8FEF02}

2.2

{76F84A17-835E-46C7-9C31-520BAFD5AC9D}

2.3

{E1660294-4C1E-4893-A40D-FFE0051E824F}

3.0

{C75C357C-3368-4142-AC8D-9F528B57373D}

[Parameter] is the installation parameter (see Parameters on page 30).

g To remove SMART Product Drivers
If you installed SMART Product Drivers using the SMART Product Drivers Installer.msi file, run
the following command to remove the software using the installation package:
msiexec /x "[Path]\SMART Product Drivers Installer.msi" [Parameter]
Where
l

[Path] is the path to the SMART Product Drivers Installer.msi file.

l

[Parameter] is the installation parameter (see Parameters on page 30).

OR
Run the following command to remove the software using the product code:
msiexec /x [Product code] [Parameter]
Where
l

[Product code] is the product code for the version of SMART Product Drivers you’re removing,
including the braces (“{” and “}”).

20

Version

Product code

10.0.124.0

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.131.0

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.163.1

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.165.1

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

CHAPT ER 4
Removing the software

l

Version

Product code

10.0.186.2

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.188.3

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.232.4

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.255.5

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.314.5

{FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.392.6

{00C68967-9790-40DA-86F7-FDB248A5CDB1}

10.0.528.7

{AA9C1126-50DD-4993-9CDC-0BED8167293C}

10.0.532.7

{984EAE92-6043-451A-B786-9327FF165310}

10.6.48.0

{2623A1E3-478A-4F4A-A522-3A3D784A0C9C}

10.6.106.1

{487F1117-8BDE-4518-A798-015172AE0410}

10.6.175.2

{333B0B76-FC96-4C51-9AF6-B6EFA15ACE99}

10.7.81.0

{1355416A-967D-47C5-823D-D493C3E0B97C}

10.7 SP1

{4CE6C6E8-0DAD-4757-86ED-7FB4035BA98B}

10.8

{67E6410C-1E97-4D03-BEC2-8E83323A6BBD}

11.0

{E3189F44-F7BD-4F96-B756-A0AEFAF61D3A}

[Parameter] is the installation parameter (see Parameters on page 30).

g To remove SMART Ink
If you installed SMART Ink using the SMART Product Drivers Installer.msi file, run the following
command to remove the software using the installation package:
msiexec /x "[Path]\SMART Product Drivers Installer.msi" [Parameter]
Where
l

[Path] is the path to the SMART Product Drivers Installer.msi file.

l

[Parameter] is the installation parameter (see Parameters on page 30).

OR
Run the following command to remove SMART Ink using the product code:
msiexec /x [Product code] [Parameter]
Where
l

[Product code] is the product code for the version of SMART Ink you’re removing, including the
braces (“{” and “}”).
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l

Version

Product code

2012 (1.0)

{4A1F2472-6164-43FA-9D2F-B35E71A8DF32}

[Parameter] is the installation parameter (see Parameters on page 30).
N OTE
Removing SMART Ink can cause your interactive product’s pens to stop responding if you
aren’t running SMART Meeting Pro 3.0 software or newer.

g To remove SMART Common Files
If you installed SMART Common Files using the SMART Product Drivers Installer.msi file, run the
following command to remove the software using the installation package:
msiexec /x "[Path]\SMART Product Drivers Installer.msi" [Parameter]
Where
l

[Path] is the path to the SMART Product Drivers Installer.msi file.

l

[Parameter] is the installation parameter (see Parameters on page 30).

OR
Run the following command to remove SMART Common Files using the product code:
msiexec /x [Product code] [Parameter]
Where
l

[Product code] is the product code for the version of SMART Common Files you’re removing,
including the braces (“{” and “}”).

l

Version

Product code

2011 (10.8)

{0E5DD7A3-BE29-430C-970B-C553F4A58C39}

2012 (11.0)

{ED2455F7-6AA6-4D3C-85E9-A72297DD7051}

[Parameter] is the installation parameter (see Parameters on page 30).
N OTE

Removing SMART Common Files can cause your SMART Software to stop responding.
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g To remove SMART Product Drivers and SMART Common Files
Run the following command:
msiexec /x "[Path]\SMART Product Drivers Installer.msi" [Parameter]
Where
l

[Path] is the path to the SMART Product Drivers Installer.msi file.

l

[Parameter] is the installation parameter (see Parameters on page 30).

Using third-party imaging or remote management
software
The following procedure shows how to remove SMART software using Windows operating systems’
Group Policy-based deployment software. For information on removing software using your
organization’s third-party imaging or remote management software, see the software’s
documentation.
N OTE
This procedure may vary depending on your version of Windows operating system and your system
preferences.
g To remove a deployed installation package
1. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.
The Active Directory Users and Computers window appears.
2. Right-click your domain, and then select Properties.
The Properties dialog box appears.
3. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
4. Browse to Computer Configuration\Software Settings\
Software Installation.
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5. Right-click the software you want to remove, and then select All Tasks > Remove.
6. Select Immediately uninstall the software from users and computers, and then click OK.
The next time each computer on the domain starts, the computer automatically removes the
software.
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Properties
SMART Meeting Pro installation package
The following are properties for the SMART Meeting Pro installation package:
Property
General properties

Allowed values

Notes
Ensure the specified MST file is in the
same folder as the MSI file.

TRANSFORMS

INSTALLDIR
ISX_
SERIALNUM
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[String]: A language MST file for the
installation (see Installation language
files and codes on page 31).

This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the installed
software’s user interface language. The
installed software uses the computer’s
operating system language if it’s
supported, or English (U.S.) if not.

You can also use the TRANSFORMS
property to apply an MST file created by
SMART Install Manager (see Using
SMART Install Manager on page 5) or a
third-party tool.
If you don’t specify a folder, Windows
[String]: The path to your preferred
Installer installs SMART Meeting Pro
folder for SMART Meeting Pro
software in [Program files]\SMART
software.
Technologies\SMART Meeting Pro.
[String]: The 22- or 25-character product This property automatically populates
the Product Key box in the activation
key you received from SMART.

APPENDIX
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Property

Allowed values

Notes
wizard if you choose not to include the
ACTIVATE_LICENSE property.
You must include the
1 (default): Register the product key and
ISX_SERIALNUM property for this
automatically activate the software.
property to work.
ACTIVATE_
[Empty string]: Register the product key
LICENSE
For mass activation information, see
but don’t automatically activate the
Activating the software after
software.
installation.
SMART Meeting Pro software properties
The SMART Bridgit server enables the
SMART Meeting Pro software
installation to connect to other
SMART Meeting Pro software
[String]: The name of the
BRIDGIT_
installations. For more information, see
SMART Bridgit server (for example,
SERVER_NAME
smarttech.com/bridgit.
bridgit.example.com).
If no server name is provided,
SMART Bridgit software integration is
disabled.
[String]: The access password for
SMART Bridgit server.
[String]: The creation password for
CREATION_PWD
SMART Bridgit server.
1: Share the main screen each time a
ENABLEBRIDGIT user starts a new session.
AUTOSHARE
0: (default) Don’t share the main screen
each time a user starts a new session.
SERVER_PWD

Users can e-mail Whiteboard files to
[String]: Type the sender e-mail address themselves or to other users in
EMAIL_ADDRESS for the SMART Meeting Pro software SMART Meeting Pro software. The
installation.
software uses this e-mail address in the
Sender field.
Users can e-mail Whiteboard files to
[String]: An e-mail server for the
themselves or to other users in
SMART Meeting Pro software
EMAIL_SERVER
SMART Meeting Pro software. The
installation (for example,
software uses this e-mail server to send
mail.example.com).
the file.
0 (default): Don’t use the computer’s
default e-mail client to send e-mail
USE_SYSTEM_
The default e-mail client must be
messages.
EMAIL
properly configured for e-mail to be sent.
1: Use the computer’s default e-mail
client to send e-mail messages.
1 (default): Use calligraphic ink, which
USE_
smoothes your writing strokes and
CALLIGRAPHIC_
improves the readability of your notes.
INK
0: Use regular ink.
CREATE_
1 (default): Include a shortcut to the
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Property

Allowed values
software on the desktop.

Notes

DESKTOPICONS [Empty string]: Don’t include a shortcut
to the software on the desktop.
1 (default): Start SMART Meeting Pro
software when the user logs on.
LOSU_
MEETINGPRO
0: Don’t start SMART Meeting Pro
software when the user logs on.
1 (default): Enable Microsoft Exchange
integration.
0: Don’t enable Microsoft Exchange
integration.
I MPOR TA N T
ENABLE_
EXCHANGE

You must also add the room
resource’s unique e-mail address
after installation or Microsoft
Exchange integration will disable (see
Adding a unique e-mail address to
each computer after installation on
page 17).
[String]: A room resource e-mail
EXCHANGE_RM_
address to link with Microsoft
EMAIL
Exchange.
1 (default): Automatically start
scheduled meeting at logon.
EX_AUTO_START
0: User must manually start scheduled
meeting after logon.
1 (default): Automatically book an
unscheduled meeting at logon.
EX_AUTO_BOOK
0: User must manually book an
unscheduled meeting after logon.
1 (default): Automatically reset room
EX_AUTO_
after meeting end time.
RESET
0: Disable automatic reset room.
EX_RESET_
DELAY
EX_AUTO_
AGENDA

GALLERYDIR
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Each computer requires a unique room
resource e-mail address.

If you select 1, an unscheduled meeting
starts automatically at logon if the room
resource is available for the next 30
minutes.

Type the preferred delay time in
5 (default): Delay time in minutes before
minutes. Only delay values of 1, 5 or 10
automatic reset room feature activates.
minutes are supported.
1 (default): Automatically insert agenda
The agenda includes any meeting
after meeting starts
details the user typed into their meeting
0: Disable automatic insertion of
invitation in Outlook.
agenda.
The path to the Added Content folder,
[CommonAppDataFolder]\SMART
which is a location on the local
Technologies\Gallery\My Content
computer where user-created content is
stored.
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Property

Allowed values
[String]: Specify the path to add
EXTGALLERYDIR
additional Gallery content folders.

Notes
This property is optional.

SMART Product Drivers installation package
The following are properties for the SMART Product Drivers installation package:
I MPOR TA N T
l

Before deploying the SMART software installation packages, you must deploy the following
third-party packages: Microsoft .NET framework 4.0 full files and Microsoft Visual Studio
Tools for Office (see Installation packages on page 3).

l

The SMART Product Drivers installation package includes SMART Ink and SMART
Common Files. You must deploy the SMART Product Drivers installation package before
you deploy the SMART Meeting Pro software installation package.

Property
General properties

Allowed values

Notes
Ensure the specified MST file is in the
same folder as the MSI file.

TRANSFORMS

INSTALLDIR

[String]: A language MST file for the
installation (see Installation language
files and codes on page 31).

[String]: The path to your preferred
folder for SMART Product Drivers.

This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the installed
software’s user interface language. The
installed software uses the computer’s
operating system language if it’s
supported, or English (U.S.) if not.
You can also use the TRANSFORMS
property to apply an MST file created by
SMART Install Manager (see Using
SMART Install Manager on page 5) or a
third-party tool.
If you don’t specify a folder, Windows
Installer installs
SMART Product Drivers in [Program
files]\SMART Technologies\SMART
Product Drivers.

SPU properties
INSTALL_SPU

SPU_TIME_
FRAME
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1 (default): Install SPU.
0: Don’t install SPU.
[Integer]: The time in days (1 to 60)
between SPU checks.

By default, SPU checks for product
updates every 30 days.
This property is applicable only if you
install SPU.
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Property
PRODUCT_
NOTIFICATION

Allowed values
1 (default): Notify the user when
updates are available from SPU.

0: Don’t notify the user when updates
are available from SPU.
SMART Product Drivers properties
1 (default): Enable the registration of
INSTALL_
SMART Document Camera drivers.
DOCCAM_
0: Disable the registration of
DRIVERS
SMART Document Camera drivers.
1 (default): Start
SMART Product Drivers after the
installation.
LOSU_
BRDTOOLS
[Empty string]: Don’t start
SMART Product Drivers after the
installation.
1 (default): Use Tablet PC functionality
with the SMART Board interactive
whiteboard without connecting a Tablet
PC.
ENABLE_
STPCS
[Empty string]: Don’t use Tablet PC
functionality with the SMART Board
interactive whiteboard without
connecting a Tablet PC.
1 (default): Start SMART Ink when the
user logs on.
LOSU_INK
[Empty string]: Don’t start SMART Ink
when the user logs on.
1 (default): Set SMART Ink Viewer as
the default PDF viewer.
DEFAULT_PDF
[Empty string]: Don’t set SMART Ink
Viewer as the default PDF viewer.
0 (default): Disable the Customer
CUSTOMER_
Experience Program.
LOGGING

INSTALL_
UNSIGNED_
DRIVERS

29

Notes
This property is applicable only if you
install SPU.

Disable the registration of
SMART Document Camera drivers if
they conflict with existing third-party
drivers on the computer.

This property is applicable to Windows
7 operating system only. It has no effect
on other operating systems.
If you specify [Null], users don’t have
touch support at the Windows logon
screen.

1: Allow the user to enable or disable
the Customer Experience Program.

1: Enable the registration of unsigned
third-party drivers.
0 (default): Disable the registration of
unsigned third-party drivers.

If you enable the registration of
unsigned third-party drivers, the
installation process could ask users if
they trust the makers of the drivers
during installation. This can cause
issues if you deploy the installation in
Silent mode. Therefore, it’s best to
disable the registration of third-party
drivers if you deploy the installation in
Silent mode.
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Parameters
The following are the standard Windows Installer parameters for the msiexec command.
Parameter

Use
Hide the installation wizard.

/q

/qb
/qb!
/qb+
/qb+!
/qr
/qf
/qn
/qn+
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N OTE
This is Silent mode.
Show a basic installation wizard.
Show a basic installation wizard without a Cancel button.
Show a basic installation wizard with a dialog box signaling the end of the
installation.
Show a basic installation wizard without a Cancel button but with a dialog box
signaling the end of the installation.
Show a reduced installation wizard.
Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
Hide the installation wizard and the dialog box signaling the end of the
installation.
Hide the installation wizard but show the dialog box signaling the end of the
installation.
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Installation language files and codes
Language
English (U.S.)
English (UK)
Chinese (Simplified)
Czech
Danish
Dutch
French (France)
German
Italian
Japanese
Norwegian
Portuguese (Portugal)
Portuguese (Brazil)
Russian
Spanish (Spain)
Spanish (Mexico)
Swedish
Turkish
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Code
1033
2057
2052
1029
1030
1043
1036
1031
1040
1041
1044
2070
1046
1049
1034
2058
1053
1055

File
1033.mst
2057.mst
2052.mst
1029.mst
1030.mst
1043.mst
1036.mst
1031.mst
1040.mst
1041.mst
1044.mst
2070.mst
1046.mst
1049.mst
1034.mst
2058.mst
1053.mst
1055.mst
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Language packs
File
chinese_(simplified)_language_pack.msi
czech_language_pack.msi
danish_language_pack.msi
dutch_language_pack.msi
english_(united_kingdom)_language_
pack.msi
french_language_pack.msi
german_language_pack.msi
italian_language_pack.msi
japanese_language_pack.msi
norwegian_language_pack.msi
portuguese_(portugal)_language_
pack.msi
portuguese_(brazil)_language_pack.msi
russian_language_pack.msi
spanish_language_pack.msi
spanish_(international_latin_american)_
language_pack.msi
swedish_language_pack.msi
turkish_language_pack.msi

32

Code
{0507C320-0AAC-48C5-A9E2-5EF1939EDF56}
{D4D68022-BE82-4C7B-87D5-2460A9BDB001}
{1EAB215B-E60D-4734-81C6-20D2A7A3B5A3}
{9B2B8676-0C52-4F97-9869-3E0CC87C85E0}
{AD53E305-0F31-426E-85D1-35C63D913639}
{015BE11B-72BE-44C4-99BA-36CA831757E4}
{5C3C89CB-A719-46C5-80C7-2E2237AD3692}
{DB9D6AF8-FC14-43B2-B3CE-5A6C8C89CF44}
{649C11F3-9B7D-423C-BB0F-AD5F985DE03A}
{E5B6189B-2FEE-4B0F-98DE-F86F04975528}
{F9914964-383B-4B92-ADEC-6A5608566219}
{97A542D0-3E82-4F73-A594-7E284559C66F}
{6BDED2D7-9987-49B1-81B8-6EB2B38B559A}
{29ADE094-DA64-46EC-835C-1DEC4A035614}
{F7C06E3B-9BC3-411C-867E-53CAE223DB13}
{640A01FF-E76A-458B-A630-EE8BCDBF4649}
{C1F6AEE2-93BE-408B-8941-856A8B69E1B7}
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hard disk space

2

I
imaging
Install Manager
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e-mail addresses

31-32

26

Microsoft .NET framework
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R
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T
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